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Thank you for purchasing the Minolta QuickScan 35. The QuickScan 35 enables you to scan both

negative and positive, color and monochrome (black & white) 35mm film using the Macintosh. 

The main features of the QuickScan 35 are as follows:

• High-speed scanning with 3-line sensors

• High-quality images with a maximum of 2820 dpi

• Easy, versatile software

The Minolta QuickScan 35 is packaged with an Adobe Photoshop plug-in software and an

independent Utility software. Before beginning to use the QuickScan 35, you should have a working

knowledge of the Macintosh and its operating conventions. You should know how to use the mouse

and standard Macintosh menus and commands.

Adobe Photoshop™ is a registered trademark of Adobe Systems Inc.

Macintosh™ is a registered trademark of Apple Computer, Inc.

Other corporate names and product names are also registered trademarks 

Changes or modifications not approved by the party responsible for compliance could void the user’s

authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device,

pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection

against harmful interference in a residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in accordance with the instructions, may

cause harmful interference to radio communications. However, there is no guarantee that interference

will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is

encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.

• Consult the dealer or an experienced radio/TV technician for help.
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END-USER LICENSE AGREEMENT

CAREFULLY READ THE LICENSE AGREEMENT BELOW BEFORE OPENING THIS PACKAGED
SOFTWARE. OPENING THIS PACKAGE INDICATES YOUR ACCEPTANCE TO THE TERMS
AND CONDITION BELOW. IF YOU DO NOT AGREE WITH THEM YOU SHOULD PROMPTLY
RETURN THE PACKAGE UNOPENED.

This is a license agreement and not an agreement for sale. Minolta owns, or has been licensed from
other owners, copyrights in the computer programs (“Software”). You obtain no rights to the
intellectual property in the Software other than the license granted to you regarding the Software
under this agreement. The title to the enclosed copy of the copy the Software and any copy made
from it is retained by Minolta or such other owners.

1. LICENSE
You may:
(1) install and use the Software on only one computer at any one time.
(2) make a copy of the Software for backup or installation purposes only in support of the normal and
intended use of the Software.
(3) transfer possession of copies of the Software to another party by transferring a copy of this
Agreement and all other documentation along with at least one complete unaltered copy of the
Software, provided that (i) you must, at the same time, either transfer to such other party or destroy all
your other copies of the Software. (ii) Such transfer of possession terminates you license from
Minolta, and (iii) such other party shall accept and be bound by these license terms by their initial use
of the Software.
2. RESTRICTIONS
You shall not without the written consent of Minolta:
(1) use, copy, modify, merge or transfer copies of the Software except as provided herein.
(2) reverse assemble or reverse compile the Software except as permitted by law; or 
(3) sublicense, rent, lease or distribute the Software or any copy thereof.
3. LIMITED WARRANTY
Minolta warrants the media on which the Software is recorded to be free from defects in materials and
workmanship under normal use. Warranty details and limitations for the Software are described in the
Statement of Limited Warranty which is supplied with the hardware. With the exception of the
foregoing express warranties applicable to hardware and media only, the Software is not warranted
and is provided “AS IS”.
SUCH WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.
4. LIMITATION OF REMEDIES
In no event with Minolta be liable for any lost profits, lost saving, or any incidental damages that result
from the use or inability to use the Software, even if Minolta or its Authorized remarketers have been
advised of the possibility of such damages or for any claim by you based on a third party claim.
5. TERMINATION
You may terminate your license at any time by destroying the Software and all your copies of it or as
otherwise described in these terms.
Minolta may terminate your license if you fail to comply with these terms. Upon such termination, you
agree to destroy all your copies of the Software.
6. GOVERNING LAW
This Agreement shall be governed by the laws of the country where the delivery is made to the
original customer.
7. GOVERNMENT END USERS
If you are acquiring the Software on behalf of any unit or agency of the United States Government, the
following provisions apply. The Government agrees: (i) if the Software is supplied to the Department
of Defense (DoD), the Software is classified as “Commercial Computer Software) and the
Government is acquiring only “restricted right” in the Software as that term is defined in Clause
252.227.7013(c)(1) of the DFARS; and (ii) if the Software is supplied to any unit or agency of the
United States Government other than DoD, the Government’s rights in the Software will be as defined
in Clause 52.227-19(c)(2) of the FAR or, in the case of NASA, in Clause 18-52.227-86(d) of the NASA
Supplement to FAR
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FOR PROPER AND SAFE USE

Various symbols are used throughout this instruction manual and

on the product itself for your proper and safe use of this product,

and to prevent personal injury, injury to others, or property damage.

An explanation of the symbols follows. Read and understand each

caution thoroughly before reading this main text of this instruction

manual.

The outer triangle is for warning, and the symbol inside

illustrates what is being warned. 

The example at left means beware of electric shock.

Disregard to this warning may result in death or injury.

Disregard to this caution may result in injury or property

damage.

Examples

The circle with a diagonal slash is for prohibition (“don’t

do”), and the symbol inside illustrates what act is

prohibited. The example at left means do not

disassemble.

The blue circle indicates something you must do, and

the symbol inside illustrates how it should be done. The

example at left means you must hold the plug when

removing it from the outlet.
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RISK OF FIRE OR  ELECTRIC SHOCK

Do not use voltage other than what is indicated.

RISK OF FIRE OR ELECTRIC SHOCK

Do not place a container of water or other liquid on the product. If water or

other liquid gets inside the product, it may cause a short resulting in fire or

electric shock. Immediately unplug, discontinue use, and contact a Minolta

Service facility.

RISK OF FIRE OR ELECTRIC SHOCK

Do not insert small metal objects into the product. This may cause a short

resulting in fire or electric shock. Immediately unplug, discontinue use,

unplug, and contact a Minolta Service facility.

RISK OF FIRE OR ELECTRIC SHOCK

Do not misuse the power cord. Damage to the cord may result in fire or

electric shock. 

Do not perform any of the following acts to the cord:

• Scratch • Modify

• Pull • Place a heavy object on

• Twis • Bend

• Heat

RISK OF FIRE OR ELECTRIC SHOCK

Do not use the product if there is smoke, a strange smell, or under any

other unusual conditions. Use under these conditions may result in fire or

electric shock. Immediately unplug, discontinue use, and contact a Minolta

Service facility.

RISK OF FIRE

Do not place the product in dusty or very humid area.

RISK OF FIRE

This product must have sufficient ventilation while in use. If the ventilation

ducts are blocked, the temperature of the interior may become hot to the

extent that fire will occur. Do not perform the following:

• Place the product on its side or upside down.

• Place the product in a closet, on a shelf, or any area without sufficient

ventilation.

• Place the product on a carpet or mattress.

• Cover the product

WARNING
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CAUTION

RISK OF FIRE OR ELECTRIC SHOCK

Grasp the plug when removing the power cord from an outlet. Pulling the

cord may damage it resulting in fire or electric shock.

RISK OF FIRE OR ELECTRIC SHOCK

Do not connect the ground to the following:

• Gas pipe

• Telephone ground

• Water pipe

RISK OF ELECTRIC SHOCK

Do not touch the power cord with wet hands.

RISK OF ELECTRIC SHOCK

Do not attempt to disassemble this product. It contains high-voltage circuits.

For repairs, contact a Minolta Service facility.

RISK OF ELECTRIC SHOCK

Connect the ground before use. If the ground is not connected, an

electricity leak may result in electric shock.

RISK OF INJURY

Do not place of the product on an unstable surface.

RISK OF INJURY

Do not sit on, stand on, or push against this product. Also, use caution

when using near children.
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BEFORE YOU BEGIN

1. Package Contents

The following contents should be included in this package.

• QuickScan 35

• SCSI cable SC-1

• Power cord

• SCSI terminator ST-1

• QuickScan 35 Control for Macintosh

• Instruction manual

• Warranty card

2. System Requirements To use the QuickScan 35 with the Macintosh, you need the

following:

• Macintosh or Power Macintosh computer with a 68030

processor with a minimum of 25MHz

• Apple system software 7.1 or higher

• A minimum of 12 megabytes (MB) of application random-access

memory (RAM) with a non-Power Macintosh

(If the Photoshop plug-in software is used, additional memory is

required)

•  A minimum of 20MB of application RAM with a Power

Macintosh

(If the Photoshop plug-in software is used, additional memory is

required)

• The Utility software requires a minimum of 8MB of RAM

• Set 32 bit in the memory control panel, virtual memory to OFF,

modem memory manager to OFF, and file share to OFF

• Photoshop Version 2.5 or higher is required to use the

Photoshop plug-in software
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NAMES OF PARTS

1.SCANNER
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PREVIEW SCAN WINDOW

8 97

17

1 2 3 4

5

6

10

11

12

13

14 15 16

1. Auto eject check box

2. Film eject button

3. Save button

4. Load button

5. Film type pop-up menu

6. Image orientation button

7. Flip button

8. Image adjustment button

9. Focus button

10. Scan mode pop-up menu

11. Scan pitch pop-up menu

12. Pixel box

13. Reset button

14. Preview scan button

15. Cancel button

16. Scan button

17. Marquee
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You will need to set an SCSI identification (ID) number for the

scanner. Each SCSI device connected to your computer must

have a different SCSI ID number.  Your Macintosh uses number

7, the internal hard disk uses number 0, and the internal CD-ROM

uses number 3. These number cannot be used. Also, determine

the SCSI ID number of any other SCSI device attached to your

computer and avoid setting these numbers as well. Please note

that the Macintosh has an SCSI ID number range of 0 to 7;

therefore, if you set the scanner ID switch to 8 or 9, the computer

will recognize it as 6.

1. Turn off the QuickScan 35. You cannot change the SCSI ID

number while the power is on. 

2. Select a number which is not used by any other SCSI device

connected to your Macintosh computer, for example a hard disk.

3. Turn the SCSI ID switch located on the rear of the scanner to

the appropriate ID number.

GETTING STARTED

･ If you are using the PowerBook or PowerBook Duo series

computer, set TERM.PWR switch to ON.

1. SETTING THE SCSI ID 

NUMBER
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1. Connect one end of the SCSI cable to one of the two SCSI

ports on the rear panel of the QuickScan 35 and the other end to

the SCSI port on the rear of the Macintosh. 

2. If the QuickScan 35 is the sole SCSI device, insert the SCSI

terminator to the open port on the rear of the scanner.

∞ If another SCSI device is connected, refer to its instruction

manual.

3. Plug in one end of the power cord to the scanner's AC inlet

and the other end to an outlet.

2. CONNECTING THE 

SCANNER
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3. INSTALLING THE

SOFTWARE

The QuickScan 35 comes with Photoshop Plug-in software and

Utility software. If you do not have Photoshop or if you want to

scan film using a fixed file size, use the Utility software. 

1. Insert the QuickScan 35 disk to the Macintosh.

2. Double click of the disk icon.

3. To install Photoshop Plug-in software, drag the Photoshop

Plug-in icon into your Adobe Photoshop plug-ins folder. If you

have Photoshop Version 3.0, drag the icon into the input/output

folder of the plug-ins folder.

To install the Utility software, drag the Utility icon into the

Macintosh hard drive folder. 
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5. SCAN FLOW CHART

Place film in the film holder emulsion side down; then insert the

film holder to the scanner as indicated on the holder.

Choose the type of film you are using from the film type pop-up

menu.

Click PreScan to preview your image.

Position the curser on a marquee handle so that it changes to an

arrowhead. Then drag until the marquee is the size you want.

Click Scan to scan the image.

If you are using the Photoshop Plug-in software, you can save the

file by selecting SAVE AS from the Adobe Photoshop File menu.

If you are using the Utility software, the file save dialog box will

appear. Enter the file name and choose the location to save the

file, then click SAVE. 

2. Specify Film Type

3. Preview

4. Cropping

5. Scan

7. Film Eject Click Eject to eject the film manually after you have scanned the

film. If you select the Auto Eject check box, the film ejects

automatically after scanning is complete.

6. File Save

1. Insert Film
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SCANNING IMAGES Before you start Photoshop or the Utility software, turn on the

QuickScan 35.

If you are using the Utility software, double click on the Utility icon.

Select Scan from the File menu.

1. START UP Start Adobe Photoshop. Then choose Acquire from the File menu

and select QS35 Plug-in.

The setup dialog appears. 

If you switch to the Utility software after using the Plug-in

software, you have to setup again. Press command, shift, and

I keys to restart the Plug-in software. Select Setup from the

File menu to restart the Utility software.
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If the computer cannot confirm interface because the QuickScan 35

power is off or there is a problem with the SCSI connection or the

SCSI ID number, a dialog box will appear. Correct the problem and

click OK.

If the scanner detects that film is loaded or that there is abnormality

in the scanner light source, a dialog box appears. Click Eject and

remove the film. 

QuickScan 35 dialog box and preview window appear, after setup.
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2.INSERTING THE FILM The QuickScan 35 can scan both color and monochrome (black &

white), positive and negative 35mm film. Both film in slide mounts

and film strips cut to a maximum of 6 frames can be scanned.

The surface of the front and back of the film is different. The front

is the base which has a glossy surface and the back is the

emulsion which has a slight matte surface. Film must be inserted

with the emulsion side facing right.

2.1. Film Strip Film strip must be placed in the film holder before inserting it into

the scanner. The film holder accepts film strips up to 6 frames

long.

1. Open the film holder.

2. Place the film on the film holder with the emulsion side down.

Frames 1 through 3 should be

placed right side up and frames

4 through 6 upside down so that

the film fits in the holder. 

2.2. Slide Mount

3. Align the frame you want to scan within the open area. 

4. Snap the film holder closed.

5. Insert the film holder into the scanner film slot with the white

lettering facing left.

The slide mount can be inserted as is.

Insert the slide mount, narrow end first, with the emulsion side

facing right.
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3. SPECIFYING THE FILM 

TYPE

Specifying the type of film you are scanning is necessary for an

accurate reproduction of the image. There are four types of film to

choose from: color negative, color positive, monochrome (black &

white) negative, and monochrome (black & white) positive.

4.  PREVIEWING THE 

IMAGE

Click PreScan to preview the image.
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5.1. Image Orientation 

Button

The image orientation button enables you to specify the correct

orientation of your image before scanning. The image in a

horizontal orientation is the default position. Click the image

orientation button to rotate the picture 90｡ clockwise. The preview

image will reflect this change.To change the rotation to counter-

clockwise, press and hold the Option key while you click the

image orientation button.

5.2. Flip Button The flip button enables you to reverse the image before scanning.

The default position is the image viewed from the film base side.

Click the flip button to flip the image left-to-right horizontally. The

preview image will reflect this change.

6. SELECTING THE 

SCAN MODE

You can select any of three scan modes: Standard, Pixel, or Print

modes.

Standard Mode

This mode is the easiest and quickest to use because the print size

and pixel number is automatically selected. 

Pixel Mode

In this mode you can set the pixel size and scanning area. This

enables you to match the image size to the size of the screen when

the monitor is your final image medium. 

Print Mode

Print mode is useful when you need to control the final image

resolution to match your printer and to set the final image size.

5. SCAN SETTINGS

The scan pitch is the number

that determines how many pixels

will form a single output signal.

The lower the scan pitch, the

higher the final image resolution,

and the larger the file size. 



19

2. Choose the scan pitch from the scan pitch pop-up menu. 

3. Crop the image as desired. The number of pixels will change

accordingly to maintain the scan pitch. 

6.1. Standard Mode 1. Choose Standard Mode from the scan mode pop-up menu.

If you want to control the pixel number, you can directly input the

number of pixels in the W (width) and H (height) boxes. The

selection will change accordingly to maintain the scan pitch. 

Scan Pitch Hint

Scan Pitch: 1

300 dpi printer produces an A4

size image

Scan Pitch: 2

300 dpi printer produces an A6

size image

Scan Pitch: 4

Image fits a 17 inch monitor

Scan Pitch: 6

Image fits a 13 inch monitor

･ Click RESET to return to the default settings.
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3. Crop the image as desired. The scan pitch changes

automatically from 1 to 24 to maintain the pixel number.

･ Click RESET to return to the default setting.

6.2. Pixel Mode 1. Choose Pixel Mode from the scan mode pop-up menu.

2. Enter the number of pixels in the W (width) and H (height)

boxes, then select the Lock check box. 
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6.3. Print Mode 1. Choose Print Mode from the scan mode pop-up menu.

2. Enter the resolution you want for the final image in the output

resolution box.

3. Select the units of measure for the final image size using the

units pop-up menu. You can select centimeters, inches, picas, or

points.

4. Roughly crop the image.

5. Enter the output image dimensions in the W (width) and H

(height) boxes and select the Lock check box.

• Click RESET to return to the default settings.

The output resolution set in

Print Mode is valid for Standard

Mode and Pixel Mode.
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7. SCANNING THE

IMAGE

When you have finished making all the adjustments to the image,

you are ready to scan the film. Click Scan. The control panel

disappears and scanning begins. 

･ If you are using the Photoshop Plug-in software, the image will

appear in a Photoshop window when the scan is complete. 

If you are using the Utility software, the save dialog box will

appear so you can save the image data. 

8. SAVING THE FILE If you are using the Photoshop Plug-in software, select SAVE AS

from the File menu. The Save As dialog box will appear. Enter the

file name and the location to save the file, then click Save.

If you are using the Utility software, the save dialog box will

appear after the image is scanned. Enter the file name and

choose the location to save the file, then click Save.

9. EJECTING THE FILM The film can be ejected manually or automatically. You should

eject the film after you have finished scanning and before you

turn off the scanner. Click Eject to eject the film manually. If you

select the Auto Eject check box, the film ejects automatically after

the scanning is complete.

When scanning negative film,

do not remove the film holder

from the scanner until it has

been properly ejected.

Removing the film, changing the

frame, and inserting the film

again without ejecting the film

first will cause image

distortions. 
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IMAGE ADJUSTMENT You can adjust the color balance, brightness, and black level of

the image. Click the image adjustment button to display the

controls.

1. COLOR BALANCE

ADJUSTMENT

This control allows you to adjust the overall black level of the

image. Drag the slider to the right to lighten the black tones in the

image or to the left to darken the black tones. Clicking one of the

arrows moves the slider one step. 

• The preview image reflects the adjustments.

• The values next to the controls show the amount of the change

brightness. The black level values range from -20 to +20.

2. BLACK LEVEL   

ADJUSTMENT

COLOR BALANCE

BLACK LEVEL

The primary colors used in scanners, as well as photography, are

red, green, and blue. The QuickScan 35's red, green, and blue

controls enable you to adjust the color of image before scanning.

Drag the slider to the right if you want to make the color more

prominent in the image or to the left to reduce the level of that

color. Clicking one of the arrows moves the slider one step.

･ The preview image reflects the adjustments.

･ The values next to the controls show the amount of the color

change. The color values range from -20 to +20.
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3. BRIGHTNESS 

ADJUSTMENT

The color level at a curser’s position on the preview image is

displayed in the lower right corner of the preview window and the

size of the selection area on the film is displayed in the upper

right corner. 

To determine the color level at a very precise point, position the

curser outside the selection area so that it changes to the cross

curser. Then position it over the area you want to measure. The

digital value of the RGB level is displayed.

• To display the CMY level, hold down the CONTROL key while

you move the mouse.

5. RGB/CMY LEVEL 

CHECKER

BRIGHTNESS

4. RESET Click the Reset button to return the image adjustment controls to

their default settings. 

This control allows you to adjust the overall brightness of the

image. Drag the slider to the right to increase brightness and to the

left to decrease brightness. Clicking one of the arrows moves the

slider one step.

• The preview image reflects the adjustments.

• The values next to the controls show the amount of the change

brightness. The brightness values range from -20 to +20.
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MANUAL FOCUS Normally, focusing is not necessary with the QuickScan 35,

however, it is recommended when your final image will be large

and if the film strip is curled or a paper slide mount is warped.

1. Click the focus button. The curser changes to the focus icon.

2. Position the focus icon over the area you want to focus and click

the mouse button.  The focus indicator window appears. 

3. Turn the focus dial on the front of the QuickScan 35 until the

black box and the red bar are their longest.

4. Click OK when you have finished focusing.
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SAVE AND LOAD

BUTTONS

The Save and Load buttons enable you to save and load several

different scanner settings. These saved settings are very useful

when you are scanning a series of images that were taken under

similar photographic conditions.

1. SAVE Click SAVE. A dialog box will appear. Enter the file name and

choose a location to save the file; then click Save.

2. LOAD Click LOAD. A dialog box will appear. Select the settings file you

want to use and click Open.

FLUORESCENT LAMP

AUTOMATIC SHUT OFF

The fluorescent light source automatically turns off if the

Macintosh has not been operated for two hours. 

• The lamp will come on again the next time youuse

QuickScan35.The setting-up takes

approximately 30 - 60 seconds

before the flourescent lamp

glows again.
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COLOR SYNC Color Sync compensates for the different color characteristics of

each instrument (i.e., monitor or printer) connected to the

Macintosh. 

1. INSTALLATION 1. If you have never used Color Sync, insert the QuickScan 35

disk to the Macintosh.

2. Double click on the disk icon.

3. Drag both the Color Sync and Color Sync System Profile icons

to the main System folder.

4. Drag the Color Sync System Profiles folder to the

preferencesSettings folder in the System folder.
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2. OPERATION

1.If you have already used Color Sync, drag the QuickScan 35

file to the Color Sync Profiles folder in the Initial Settings folder.

2.Drag the Color Sync Filter icon to the Plug-in folder in

Photoshop.

1. When the scanned image appears in the Photoshop window,

choose Color Sync from Others in the Filter menu. 

2. The Color Sync dialog box appears with the following

information:

Source Profile: MINOLTA QuickScan 35

Destination Profile: Monitor in use

Matching Option: Photographic

5. Drag the Color Sync Filter folder to the Photoshop Plug-ins

folder.
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TROUBLE SHOOTING Q:The Macintosh does not start up after connecting the

QuickScan 35.

A:Turn power off, then check SCSI cable, SCSI connection, and

SCSI ID number.

Q:QS35 Plug-in does not appear in the plug-in menu.

A:Check the plug-in folder selection in the "Plug-in..." menu in the

Optional Settings of Photoshop.

Q:Operation stops during plug-in setup, preview, or scan.

A:Check System Requirements on page XX.

A:Turn power off, then check SCSI cable, SCSI connection, and

SCSI ID number.

Q:Scan speed is extremely slow with Plug-in software.

A:Increase Photoshop memory.

Q:"Insufficient Memory" message appears.

A:If you are using the Utility software, increase memory.

A:If you are using the Photoshop Plug-in software, increase

Photoshop memory.

A:If the message appears several times during the use of

Photoshop, restart Photoshop.

Q:Grain is visible when scanning high-speed film.

A:Slightly defocus the image using manual focus.

Q:Color is unusual when scanning color negative film, especially

images taken under fluorescent lighting.

A:Scan again or correct the color using the color adjustment

function.

Q:"Change the flourescent lamp" message appears.

A:Change the fluorescent lamp. Contact a Minolta Service facility.

Q:Film is not inserted, but "Film loaded or Scanner Error

detected. . . ." message appears.

A:Change the fluorescent lamp. Contact a Minolta Service facility.



30

SPECIFICATIONS Type:Film transport type 

Usable Film:35mm negative/positive, color/monochrome (black &

white) films

Scanning Dimensions:24.2mm x 36.3mm; Maximum 2820 dpi

(2688 x 4032 pixels)

Pixel Density:110 pixels/mm, 2828 dpi (on film)

Interface:SCSI2

Scanning Time:Scanning:approx. 12 sec. (1000 x 1000 pixels)

approx. 60 sec. (2688 x 4032 pixels)

Preview:approx. 6 sec. (positive)

Image Sensor:RGB 3-line color CCD

Light Source:Fluorescent lamp

Color Separation Sequence:1 pass

Focus:Focus detection: High-frequency detection type

Focus adjustment: Manual

Dimensions:100(W) x 169(H) x 300(D)mm

Weight:3.3kg

Power Consumption:Less than 30W

Operating Temperature and Humidity:Temperature: 10 to 35°C;

Humidity: 20 to 80%
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